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AutoCAD FUNDAMENTALS
A.  COORDINATE ENTRY


A rectangular coordinate system called the World Coordinate System (WCS) is used during drawing creation to establish starting points for objects such as lines, circles and arcs.  Coordinates are also used with commands like move, copy and mirror to relocate original objects to a new location on the graphics display.  A User Coordinate System (UCS) is a temporary, moveable coordinate system, which provides more flexibility during certain drawing applications, especially those operations related to 3D wireframe drawings.


The main emphasis during this discussion will be towards the use of the World Coordinate System and the coordinate entries you will be using most frequently during your drawing applications.  The WCS contains X and Y axes which are perpendicular to each other.  The X-axis represents a HORIZONTAL location and the Y-axis represents a VERTICAL location.  The X value is always input FIRST, and the Y value is always input SECOND.  The point where the X and Y axes meet (intersect) is called the origin point and always has an X,Y value of 0,0.  This is always located in the LOWER LEFT-HAND corner of the rectangular display, regardless of the size of the Drawing Limits used for the drawing session.  This coordinate system is the one you will use for all 2D drawing creations.  There are four types of coordinate entry that will be discussed.  The following pages describe these four types of coordinate entry.


ABSOLUTE COORDINATES.  You can specify a points exact location by entering its’ X and Y location as they relate to zero.  The format for entering an Absolute Coordinate is X,Y.  Both values MUST be separated during input by a comma.  The first value is the points HORIZONTAL location (X) from "0" and the second value is the VERTICAL location (Y) from "0”.  Look at the figure below to see how the four lines were drawn using Absolute Coordinate entry.
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RELATIVE COORDINATES.  To establish the location of a point, which is RELATIVE to the location of the last point you established, you can enter a Relative Coordinate.  All Relative Coordinates MUST begin with the @ symbol before X and Y values can be input.  If a point will not move left or right in the X-axis, then "0" will be the value to input for the X-axis.  If a point will not move up or down in the Y-axis, then "0" will be the value to input for the Y-axis.  A value starting with a negative sign (-) will move to the left in the X-axis and move down in the Y-axis.  All values that are input identify HORIZONTAL or VERTICAL distance from the last point that was established.  The diagram below depicts the relationship of Relative Coordinates.
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RELATIVE POLAR COORDINATES:  This type of coordinate entry is possibly the most common type of input and probably the easiest for beginners to master to create any drawings.  A Relative Polar Coordinate MUST begin with the @ symbol.  The next values that will be input are the linear distance and angular direction the new point is from the previous point you established.  After the linear distance is input the next thing that MUST be input is the < (angle) symbol, which identifies the coordinate as Relative Polar.  The last value to enter is the angle the new point projects from the last point that was established. Angular direction is based on 0 degrees being to the right, 90 degrees straight up, 180 degrees to the left and 270 degrees straight down.  The following figure will help you visualize the way Relative Polar Coordinates are input to create a drawing.  The X and Y axes are not used in entering Relative Polar Coordinates.
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DIRECT DISTANCE ENTRY TO DEFINE A POINT:  You can specify a point with direct distance entry by moving the cursor to indicate a direction and then entering the distance from the first point.  This method is a good way to specify a line length quickly.  You can use direct distance entry to specify points for all commands except those that you enter a single real value such as ARRAY, MEASURE, or DIVIDE.  When Ortho mode is on, this method is an efficient way to draw horizontal and vertical lines.  In the following example, you will draw a line 25 units long using direct distance entry.

To draw a line using direct distance entry:

1.  From the Draw toolbar

2.  Select the Line icon [image: image5.png]


 by picking it with the left mouse button

3.  Command prompt sequence:


A.  _line Specify first point:  Type 4,4 (Absolute Coordinate), then press Enter.


B.  Specify next point or [Undo]:  Move the mouse until the rubber-band line extends at the same angle and direction as the point you want to specify.  On the command line, type 6 to specify a distance, then press Enter.

  
C.  Specify next point or [Undo]:  Press Enter again to exit the line command.

Alternative:  You can use polar coordinates to find a point by specifying a distance and angle.  

Related:  You can set the coordinate display below the graphics area to show the distance and angle in the in the distance<angle format.

To draw a rectangle using direct distance entry:

1.  From the Draw toolbar

2.  Select the Line icon [image: image6.png]


 by picking it with the left mouse button

3.  Command prompt sequence:


A.  _line Specify first point:  Type 5,3 (Absolute Coordinate), then press Enter.


B.  Specify next point or [Undo]:  Ensuring ortho is on, move your mouse to the right and type 3, then press Enter.

C.  Specify next point or [Undo]:  Move your mouse up so the rubber band image is in the up direction, type 4, then press Enter.


D.  Specify next point or [Close/Undo]:  Move your mouse to the left so the rubber band image is pointing to the left, type 3, then press Enter. 


E.  Specify next point or [Close/Undo]:  Type C for close, then press Enter.  

STUDENT NOTES:
B.  OBJECT SNAPS

Object snaps (Osnap) are modes for selecting commonly needed points on an object while you create or edit an AutoCAD drawing.  A primary advantage of object snap is not having to pick an exact point on an object when selecting it.  Using object snap is a quick way to locate an exact point on an object without knowing the coordinates.
Object snaps can be accessed in the following ways:


1st - Using the Object Snap Toolbar.

2nd - From the Standard Toolbar

3rd - By pressing and holding down the shift key and then pressing the right mouse button.


4th – Through the use of the screen menu

Note:  You can set Osnaps to be on at all times.  These are called Running Object Snaps.  The Running Object Snaps may be selected from the Tools pull-down menu and then selecting Drafting Settings….  Now pick the Object Snap tab to make it current.


The following is a brief description of the Object Snaps we will use most during this phase of the course.

From [fro]  The From object snap differs from the other types of object snaps because it establishes a temporary reference point as a basis for specifying subsequent points.  The from object snap is used in combination with other object snaps and relative coordinates. 

Endpoint [endp]  Endpoint snaps to the closest endpoint of objects such as lines, polylines, arcs and curves.

Midpoint [mid]  Midpoint snaps to the midpoint of objects such as lines, arcs or splines.  In the case of a polyline, it selects the midpoint of the polyline segment.

Intersection [int]  Intersection snaps to the intersection of objects such as lines, circles, arcs, and splines.  If the target area only covers one object, AutoCAD prompts you to select a second object and then snaps to the imaginary intersection formed by extensions of those objects.

Apparent Intersection [appint or app]  Apparent Intersection snaps to a real or visual 3D intersection formed by objects you select or by an extension of those objects.

Center [cen]  Center snaps to the center of an arc, circle, or ellipse.  You must pick the arc, circle or ellipse itself, not its apparent center.

Quadrant [qua]  Quadrant snaps to the closest quadrant of an arc, circle, or ellipse (the 0-, 90-, 180-, and 270-degree points.

Tangent [tan]  Tangent snaps to the point on an arc, circle, ellipse, or planar spline that forms a tangent to another object.

Perpendicular [per]  Perpendicular snaps to the point on an object that forms a normal or perpendicular alignment with another object or with an imaginary extension of the object.  You can use the Perpendicular object snap with objects such as lines, circles, ellipses, splines, or arcs.

Insertion [ins]  Insertion snaps to the insertion point of a block, shape, text, attribute (which contains information on a block), or attribute definition (which describes the characteristics of the attribute).

Node [nod]  Node snaps to a point object drawn with the Point command.

Nearest [nea]  Nearest snaps to a point on an object or to the location on another type of object that is closest to the specified point.

None [none]  None disables both single and running object snaps.

C:  LIGHT SWITCH COVER PLATE PRACTICAL EXERCISE


[image: image7.wmf]
The following demonstration will introduce you to some of the basic command sequences that you will learn to complete the LIGHT SWITCH COVER drawing shown above.  Follow the command sequences shown below by selecting the respective pull-down menus and inputting the various coordinates discussed in Chapter 2A.

1.  With the left mouse button, pick the File pull-down menu and then pick New….

2.  In the Create New Drawing dialog box, ensure the Use a Template button [image: image8.png]


 is selected.  If it is not, select the Use a Template icon by picking it with the left mouse button.  Now in the Select a Template list box, scroll down and select the Ansi c-color dependent plot styles.dwt file by double clicking it with the left mouse button or pick it once with the left mouse button and then select/pick the OK button.

3.  An outline of an Ansi C-size drawing sheet appears on your screen.
"LINE COMMAND"
1.  From the Draw toolbar

2.  Select the Line icon [image: image9.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  _line Specify first point:  Type 2,2  (Absolute Coordinate), then press Enter.


B.  Specify next point or [Undo]:  Type 6.5,2  (Absolute Coordinate), then press Enter.


C.  Specify next point or [Undo]:  Type @0,4.5  (Relative Coordinate), then press Enter.


D.  Specify next point or [Close/Undo]:  Type @-4.5,0  (Relative Coordinate), then press Enter.


E.  Specify next point or [Close/Undo]:  Type C for close, then press Enter.
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When drawing lines, AutoCAD displays a rubber band line to show you where the next resulting line segment will go.  You can tell AutoCAD where to place the endpoint of the next line by moving the crosshairs to a new location on the screen and pressing the pick button (LEFT button) on your mouse.  The correct and more accurate method is inputting coordinates (Absolute, Relative, or Relative Polar) or using the direct distance method.  The edges of the light switch cover are now complete.  Next we must draw the mounting holes and switch cutouts.


Zoom in on the box you just created using the Zoom Icon button or using View, Zoom, Window from the pull-down menu.

"CIRCLE COMMAND"
1.  From the Draw toolbar

2.  Select the Circle icon [image: image11.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  _circle Specify center point for circle or [3P/2P/Ttr (tan tan radius].  Type 3.38,3.13  (Absolute Coordinate), then press Enter.


B.  Specify radius of circle or [Diameter].  Type 0.125 and press Enter.
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At the last prompt, Specify radius of circle or [Diameter], you had a choice of entering either the radius or the diameter of the circle.  Radius was the default choice.  AutoCAD assumed the number you were going to enter would be the radius of the circle.


In order to enter a diameter for the circle instead, first, at the keyboard, enter the letter D, and then press Enter.  This will switch the default radius command to diameter and enable you to enter the diameter of the circle instead.


The first mounting hole for the switch cover is now complete.  Next you will make a copy of the circle by using the Copy command.  But, before you do, we'll introduce an important feature:  SELECTION SETS.

"SELECTION-SETS" 

Many of the editing commands in AutoCAD ask you to select the objects you want to edit.  To specify these objects, you create a selection-set.


A selection-set is one or more objects that you can identify to perform specified editing operations at one time.  When you see the prompt Select objects: AutoCAD is asking you to select the objects you want to edit.  You can select as many objects as you like in a selection-set.  When you are finished selecting the objects you want to edit, press Enter.  There are three ways to create a selection-set in AutoCAD.  In the next demonstration, you will learn how to select objects to edit by using selection-sets.  For detailed information on "Selection sets" see Appendix A.

Now you will make a copy of the first circle you drew and place it in the proper location on the cover plate.

"COPY COMMAND"
1.  From the Modify toolbar

2.  Select the Copy icon [image: image13.png]%



 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Command: _copy

     Select objects:  Pick the circle using the left mouse button.  Pick the circle itself, not the inside of the circle.


B.  Select objects:  1 found

     Select objects:  Press Enter or the right mouse button to accept the selection-set.


C.  Specify base point or displacement, or [Multiple]:  Select Snap to Center object snap and pick the circle using the left mouse button to specify the center of the circle as the base point for copying/picking up the circle.


D.  Specify Base point or displacement, or [Multiple]:  _cen of Specify second point of displacement or <use first point as displacement>:  Type @2.24<90 (Relative Polar Coordinate), then press Enter.
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Two of the four mounting holes are now complete.  Now it's time to draw the switch cutout.  To do this, draw a rectangle 0.38 units wide by 1.0 unit long. You can use the same method you used previously to draw the first three sides of the cover.  To draw the fourth side, use the Close option.  Follow the command prompts below, but be sure you understand each method of point placement as you enter them.  If you make a mistake, enter U from the keyboard at the very next command prompt to undo it.

"LINE COMMAND"
1.  From the Draw toolbar

2.  Select the Line icon [image: image15.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  _line Specify first point:  Type 3.19,3.75 (Absolute Coordinate), then press Enter.


B.  Specify next point or [Undo]:  Type @0.38<0 (Relative Polar Coordinate), then press Enter.


C.  Specify next point or [Undo]:  Type @1<90 (Relative Polar Coordinate), then press Enter.


D.  Specify next point or [Close/Undo]: Type @0.38<180 (Relative Polar Coordinate), then press Enter.


E.  Specify next point or [Close/Undo]:  Type C for close, then press Enter.
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The light switch cover is almost complete.  You can create a mirror image of the mounting holes and switch cutout using SELECTION SETS, the MIRROR command and a drawing aid called ORTHO MODE.

"ORTHO MODE"


Before you go further, select the F8 key on your keyboard or double click with your left mouse button on the ORTHO block in the status bar at the bottom of the screen.  Notice that the ORTHO button appears to be depressed.


This turns on ORTHO mode, which will help you position objects at 90-degree angle increments in relationship to the crosshairs.  You may turn ORTHO mode on or off anytime you like, even while other commands are in progress.

"MIRROR COMMAND"

Using the Mirror command, select the objects to be duplicated using a selection set consisting of the two mounting holes and the switch cutout.  Next, indicate to AutoCAD where to place a temporary mirror line that will be used to reproduce the mounting holes and cutout.  Then create the mirror image.  Follow the sequence below to mirror the mounting holes and switch cutout. 

1.  From the Modify toolbar

2.  Select the Mirror icon [image: image17.png]A



 by picking it with the left mouse button. 

3.  Command prompt sequence:


A.  Command: _mirror 

      Select objects:  Use the selection-set method and pick both mounting holes and the light switch cutout, then press Enter.


B.  Specify first point of mirror line:  Select Snap to Midpoint object snap and move your mouse cursor to either the top or bottom line of the light switch cover (near the midpoint of the line) until you see a yellow triangle and the tooltip Midpoint and then pick your left mouse button.


C.  Specify first point of mirror line:  _mid of Specify second point of mirror line:  Move the mouse until the mirrored objects are to the right of the originals and pick the left mouse button.


D.  Delete source objects?  [Yes/No] <N>:  Press Enter to accept the default of no to keep the original objects. 

The light switch cover is complete as shown below.

[image: image18.png]i
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Save the cover drawing.  Pick the word File from the pull-down menu, and then pick Save As….  At the Save Drawing As dialog box, type Cover Plate and then go to the Save in: rectangular box and select the Compaq (C:) directory.  Now double click the Student directory to make it current and then pick the Save button.

"REDRAW ALL COMMAND"

This command is used to refresh the graphic display area. 

1. Select the Redraw All icon [image: image19.png]


 from the standard toolbar by picking it with the left mouse button or,

Select the View pull-down menu by picking it with the left mouse button, then select Redraw by picking it with the left mouse button.

"ERASE COMMAND"

The Erase command is used to remove objects from your graphic display area (drawing screen).

1.  From the Modify toolbar

2.  Select the Erase icon [image: image20.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Command: _erase  

     Select objects:  Using the selection-set method, pick all the objects of the cover plate drawing using a window or crossing window using the mouse.


B.  Select objects:  Press the Enter key or the right mouse button to complete the command.

"UNDO COMMAND"

To reverse the effects of the Erase command, or any other command, you can enter the Undo command.  This command allows you to experiment with commands and features in AutoCAD without having to keep the results.  The Undo command has several options and can be a useful tool when you are not sure how a particular command will act.  Bring back the cover drawing using the Undo command to reverse your last AutoCAD command.

1. Select the Undo icon [image: image21.png]


 from the standard toolbar by picking it with the left mouse button or,

Select the Edit pull-down menu by picking it with the left mouse button, and then select the Undo command by picking it with the left mouse button.

"REDO COMMAND"

The Redo command is the only tool that lets you undo an Undo command.  The Redo command WILL ONLY REDO ONCE regardless of how many Undo commands were used previous to using the Redo command.  Erase the cover plate drawing again by using the Redo command.

1. Select the Redo icon [image: image22.png]


  from the standard toolbar by picking it with the left mouse button or,

Select the Edit pull-down menu by picking it with the left mouse button, and then select the Redo command by picking it with the left mouse button.

Finally, bring back your cover plate drawing using the Undo command.

D.  OBJECT DEMO PRACTICAL EXERCISE


The following practical exercise will familiarize you with the rest of the basic editing commands.  Follow the command sequences listed to accomplish each respective editing task. Use the c:\student\objdemo.dwg drawing file to help you complete each editing task.
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TASK 1 - "ARRAY COMMAND"
1.  From the Modify toolbar

2.  Select the Array icon [image: image24.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Command: _array  

     Select objects:  Pick CIRCLE #2 (the circle itself, not the inside) with the left mouse button, then press Enter.  This is the object you want to ARRAY.


B.  Enter the type of array [Rectangular/Polar] <R>:  Type the letter "P" and then press Enter

C.  Specify center point of array:  Select Snap to Center object snap and pick CIRCLE #1 with the left mouse button (the crosshairs just need to touch the object line of the circle).  This is the point that CIRCLE #2 will rotate around.


D.  Enter the number of items in the array:  Type the number 4 and press Enter.  This is how many copies of CIRCLE #2 will be shown when the ARRAY command is complete.


E.  Specify the angle to fill (+=ccw, -=cw)  <360>:  Accept the default of 360 by pressing Enter.  This will copy the objects around the center point full circle.


F.  Rotate arrayed objects [Yes/No] <Y>:  Press Enter to accept the default of Y (Yes).
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TASK 2:  "CHAMFER COMMAND"
1.  From the Modify toolbar

2.  Select the Chamfer icon [image: image26.png]


  by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select first line or [Polyline/Distance/Angle/Trim/Method]:  Type D to set the chamfering distances and then press Enter.


B.  Specify first chamfer distance <0.0000>:  Type 0.25 and press Enter.


C.  Specify second chamfer distance <0.2500>:  Press Enter to accept the default value of 0.2500.  This will create 45-degree chamfers.


D.  Command:  Press Enter to return to the Chamfer command.


E.  Select first line or [Polyline/Distance/Angle/Trim/Method]:  Type P to select Polyline and press Enter.  (Both boxes are polyline objects.)


F.  Select 2D Polyline:  Pick BOX #1 with the left mouse button.
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TASK 3:  "OFFSET COMMAND"
1.  From the Modify toolbar

2.  Select the Offset icon [image: image28.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Specify offset distance or [Through]  <Through>:  Type 0.5 and press Enter. This is the distance a copy of LINE #4 will be from the original line.


B.  Select object to offset or <exit>:  Select LINE #4 by picking it with the left mouse button. 


C.  Specify point on side to offset:  Position your crosshairs to the right of LINE #4 and pick the left mouse button.  This will create a parallel copy of LINE #4 to the right of the original line.


D.  Select object to offset or <exit>:  Press Enter to exit the Offset command.
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TASK 4: "BREAK COMMAND"
1.  From the Modify toolbar

2.  Select the Break icon [image: image30.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  _break Select object:  Select LINE #1 by picking it with the left mouse button.


B.  Specify second break point or [First point]:  Type F (for first point) and press Enter.


C.  Specify first break point:  Select Snap to Intersection object snap and pick point #1 with the left mouse button.


D.  Specify second break point:  Select Snap to Intersection object snap and pick point #2 with the left mouse button.  This will break away the line segment between points #1 and #2.
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TASK 5:  "EXTEND COMMAND"
1.  From the Modify toolbar

2.  Select the Extend icon [image: image32.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select boundary edges . . .


      Select objects:  Select the vertical line of the RIGHT ANGLE by picking it with the left mouse button.


B.  Select objects:  1 found

      Select objects:  Press the Enter key or the right mouse button.


C.  Select object to extend or [Project/Edge/Undo]:  Select LINE #2 with the left mouse button.

D.  Select object to extend or [Project/Edge/Undo]:  Press  Enter to exit the Extend command.
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TASK 6:  "MOVE COMMAND"
1.  From the Modify toolbar

2.  Select the Move icon [image: image34.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select objects:  Select CIRCLE #3 and #4 by picking them with the left mouse button, the press Enter.


B.  Specify base point or displacement:  Select Snap to Center object snap and move your crosshairs over top of either CIRCLE #3 or #4 and pick your left mouse button.


C.  Specify base point or displacement:  _cen of Specify second point of displacement or <use first point as displacement>:  Select Snap to Center object snap and move your crosshairs over top of CIRCLE #1 and pick your left mouse button.  This is where you want to move CIRCLE #3 and #4 to.
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TASK 7:  "SCALE COMMAND"
1.  From the Modify toolbar

2.  Select the Scale icon [image: image36.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select objects:  Select BOX #1 by picking it with the left mouse button, then press Enter.


B.  Specify base point:  Select Snap to Midpoint object snap and pick any side of BOX #1 with the left mouse button.


C.  Specify scale factor or [Reference]:  Type the number 2 and then press Enter.  This value will scale BOX #1 to TWICE its original size.  Any scale factor less than 1 will reduce the original object/s by that scale factor.
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TASK 8:  "STRETCH COMMAND"
1.  From the Modify toolbar

2.  Select the Stretch icon [image: image38.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select objects:  Use a CROSSING WINDOW selection-set and select the top, bottom and right sides of BOX #2 (with the left mouse button, pick a point to the right and below the bottom line of Box #2, then move your mouse cursor to the left and halfway across Box #2 and pick a point above Box #2’s top line), then press Enter.  
B.  Specify base point or displacement:  Select Snap to Midpoint object snap and move your crosshairs to the right side line of Box #2 until you see a yellow triangle appear.  Now pick the right side of BOX #2 with the left mouse button.


C.  Specify second point of displacement:  Type @1.5<0 then press Enter.  This will stretch BOX #2 1.5 units to the right.
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TASK 9:  "ROTATE COMMAND"
1.  From the Modify toolbar

2.  Select the Rotate icon [image: image40.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select objects:  Select LINE #3 by picking it with the left mouse button, then press Enter.


B.  Specify base point:  Select Snap to Midpoint object snap, move your crosshairs to LINE #3 and pick LINE #3 with the left mouse button.  This is the point the line will rotate around.


C.  Specify rotation angle or [Reference]:  Turn ORTHO on by pressing the F8 key and move your mouse until the ghosted image of LINE #3 is vertical and then pick the left mouse button.  Don’t let your mouse move when picking the left mouse button.
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TASK 10:  "TRIM COMMAND"
1.  From the Modify toolbar

2.  Select the Trim icon [image: image42.png]


 by picking it with the left mouse button.

3.  Command prompt sequence:


A.  Select cutting edges . . .


      Select objects:  Select LINE #2 by picking it with the left mouse button, then press Enter.


B.  Select objects to trim or [Project/Edge/Undo]:  Select the vertical line of the RIGHT ANGLE at the point indicated by picking it with the left mouse button.


C.  Press the Enter key to exit the Trim command.
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E.  DRAWING SETUP AND CHANGING DRAWING SETTINGS


DYNAMIC DIALOG BOXES.  Some of the more powerful editing commands you will be working with next will be manipulated through the aid of dynamic dialog boxes.  Through the use of dialog boxes, the process of editing drawings becomes streamlined.  Dialog boxes allow you to preset settings, preview end results, and correct mistakes more quickly.  One of the biggest advantages of using dialog boxes is they help speed up the learning process for beginners.  Before we get started on the creation of your next drawing we will give you a brief overview of what the AutoCAD dynamic dialog boxes are all about.  The following dynamic dialog boxes will help you speed up the creation of your drawings even more!

"DRAWING UNITS"

1.  Select the Format pull-down menu by picking it with the left mouse button.

2.  Select the Units... command by picking it with the left mouse button.
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LENGTH TILE.  This area allows you to set the LINEAR UNITS for your current drawing session.  Simply select/pick the desired linear units format from the Type: drop-down list and use the Precision: drop-down list to specify the linear units precision.


ANGLE TILE.  This area lets you set the ANGULAR UNITS for your current drawing session.  Selecting the angular units and precision in the Angle tile is done the same way as in the Length tile.  An additional option located at the bottom of the dialog box is the Direction... button.  Selecting this button allows you to change the location of "0" and the direction the angular measurements go (Clockwise or Counter-Clockwise).

"DRAWING LIMITS"
1.  Select the Format pull-down menu by picking it with the left mouse button.

2.  Select the Drawing Limits command by picking it with the left mouse button.


Drawing limits are values you set to define the drawing limits (boundaries) of your drawing area.  The limits that are established for any drawing session control how much of the display area will be covered by the GRIDS and how much of the drawing will be displayed using the View, Zoom, All command.

"LAYER CONTROL"
1.  Select the Format pull-down menu by picking it with the left mouse button.

2.  Select the Layer... command by picking it with the left mouse button.

Note:  Picking the Layers icon [image: image45.png]


  with the left mouse button from the Object Properties Toolbar also brings up the Layer Properties Manager dialog box.
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THE LAYER CONTROL SETTINGS PROVIDE YOU WITH ONE OF THE MOST POWERFUL DRAWING AIDS ASSOCIATED WITH AutoCAD.  These settings allow you to DISPLAY, or PLOT, any combination of objects that make up your drawing.  Objects (Entities) can be assigned specific names, colors and linetypes to aid in how the final drawing will look.

F.  SUPPORT BRACKET PRACTICAL EXERCISE (BEGIN)

You are now ready to create the SBRACKET drawing.  Following the instructor led demonstration and using the command sequences provided here as a reference, you will begin your next drawing session by establishing the initial drawing settings.  Select the File pull-down menu by picking it with the left mouse button, then select the New... command by picking it with the left mouse button.

In the Startup or Create New Drawing dialog box, select the Use a Template icon [image: image47.png]


 with the left mouse button, scroll down, and open the Ansi c –color dependent plot styles.dwt file by double clicking it with the left mouse button or pick it once with the left mouse button and then pick the OK button.
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NOTE:  FROM THIS POINT FORWARD, WHENEVER YOU ARE TOLD TO SELECT OR PICK AN ITEM, IT MEANS TO PICK THAT ITEM USING THE LEFT MOUSE BUTTON.  WHENEVER YOU ARE TOLD TO ENTER SOMETHING YOU CAN EITHER PRESS ENTER ON THE KEYBOARD OR PICK THE RIGHT MOUSE BUTTON. 

"UNITS CONTROL"
1.  Select the Format pull-down menu.

2.  Select the Units… command.

3.  Set up the Drawing Units dialog box using the following criteria:


A.  Length tile Type: = Decimal


B.  Length tile Precision: = 0.00 (Two decimal places)


C.  Angle tile Type: = Decimal Degrees


D.  Angle tile Precision: = 0 (Whole degrees)


E.  Pick the Direction... Button.  Base Angle is East “0.00”.  Pick the OK button)


F.  Drawing units for DesignCenter blocks tile = Inches 


G.  Pick the OK button to accept these settings.


We will now set the drawing limits.  To do this, first pick the PAPER button at the bottom of your screen with the left mouse button.  The word PAPER should change to the word MODEL and you should see a double thick black line around your drawing area on your drawing sheet.  Now set your drawing limits.

"DRAWING LIMITS"
1.  Select the Format pull-down menu.

2.  Select the Drawing Limits command.

3.  Command prompt sequence:


A.  Specify lower left corner or [ON/OFF]  <-0.00,0.00>:  Press the Enter key to accept the default values.


B.  Specify upper right corner  <12.00,9.00>:  Type 22,17 then press Enter.


C.  Pick the Zoom All Icon [image: image49.png]


 to change the drawing screen to the new drawing limits. 

"LAYER CONTROL"
1.  Select the Layers icon [image: image50.png]


 from the Object Properties toolbar or select Format from the pull down menu and then select Layer….  The Layer Properties Manager dialog box shown below appears on your screen.
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2.  Use the following layer specifications to create the layers for this drawing:

Layer Name

Color

Linetype

Lineweight
Center

Red

Center

0.30 mm



Dimension

Green

Continuous

0.30 mm

Hidden

Yellow

Hidden

0.30 mm

Object


White

Continuous

0.60 mm

Text


Cyan

Continuous

0.60 mm


We will first create the Center layer and assign the correct color, linetype, and lineweight to it.  


In the upper right hand corner of the Layer Properties Manager dialog box, select the New button.  Type the word Center and press the Enter key.  Now move your mouse cursor over the word White (in the blue highlighted area) below the Color button and pick your left mouse button.  Move your mouse cursor to the color red in the Standard Colors tile, pick your left mouse button, and then pick the OK button.  Notice that the color red is now assigned to the Center layer.


Now move your mouse cursor over the word Continuous (in the blue highlighted area) below the Linetype button and pick your left mouse button.  In the Select Linetype dialog box, pick the Load… button.  Scroll down until you see the word Center, move your mouse cursor on top of the word Center, and pick your left mouse button.  Now select the OK button.  Back in the Select Linetype dialog box, move your mouse cursor over the word CENTER, pick your left mouse button, and then pick the OK button.  Notice that the CENTER linetype is now assigned to the Center layer.


Next we will select a Lineweight for the Center layer.  Move your mouse cursor on top of the word Default (in the blue highlighted area) below the Lineweight button and pick your left mouse button.  Now move your mouse cursor on top of 0.30 mm linetype and pick your left mouse button to highlight it, then pick the OK button.  Notice that the Lineweight of 0.30 mm is now assigned to the Center layer.


Using the 3 paragraphs above, create the rest of the other layers and assign the correct properties (color, linetype, and lineweight) to each of them.

NOTE:  The 0,Title Block, and Viewport layers will already be established in the Layer Properties Manager dialog box, however, you must change the Lineweight of the Title Block layer to 0.60mm.


Your completed Layer Properties Manager dialog box should now look like the following:
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After ensuring your LAYER PROPERTIES MANAGER dialog box looks like the one above, pick the OK button.  Now save the SBRACKET drawing.  Pick the word File from the pull-down menu, and then pick Save As….  At the Save Drawing As dialog box, type SBRACKET and then go to the Save in: rectangular box and select the Compaq (C:) or Drive_c (C:) directory.  Now double click the Student directory to make it current and then pick the Save button. 

NOTE:  The next time you access the LAYER PROPERTIES MANAGER dialog box, the layers will appear in alphabetical order.


Figure 2.1 below contains the multi-views that you will be initially creating.
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Figure 2.1

Using the following specifications, create the SUPPORT BRACKET (SBRACKET) drawing following the Instructor led demonstration.  You will create the front view object lines of the SUPPORT BRACKET (SBRACKET) drawing with the instructor. 

SUPPORT BRACKET (SBRACKET) SPECIFICATIONS

LAYERS:

Layer Name

Color

Linetype

Lineweight
0


White

Continuous

Default

Title Block

White

Continuous

0.60mm

Viewport

White

Continuous

Default

Center

Red

Center

0.30 mm



Dimension

Green

Continuous

0.30 mm

Hidden

Yellow

Hidden

0.30 mm

Object


White

Continuous

0.60 mm

Text


Cyan

Continuous

0.60 mm

DRAWING SPECIFICATIONS:

1.  DRAWING SHEET:  Ansi c –color dependent plot styles.dwt

2.  DRAWING UNITS PRECISION:  2 DECIMAL PLACES

3.  DRAWING LIMITS:  LOWER LEFT CORNER 0.00,0.00

     UPPER RIGHT CORNER 22.00,17.00  

4.  TEXT STYLE:  AutoCAD DEFAULT

5.  TEXT HEIGHT:  #5 - USE .12;  #7 - USE .24

6.  START POINT:  7,7
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STUDENT NOTES

G.  DIMENSIONING AND TEXT

During this next instructor-assisted demonstration, you will learn some of the basic procedures involved to DIMENSION and place TEXT on your drawing. The instructor led demonstration will cover how to place Center Marks, Center Marks with Lines, Radial, Linear, and Baseline dimensions.

1.  Select the Dimension Style icon [image: image55.png]


 from the Dimension toolbar or select Format from the pull down menu and then select Dimension Style….  The Dimension Style Manager dialog box shown below appears on your screen.


DIMENSION STYLE MANAGER DIALOG BOX
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The Dimension Style Manager dialog box is the gateway to dimension styles.  With this dialog box, you can create new dimension styles, edit existing ones, or make an existing dimension style current.


The following paragraphs give you a brief overview of some of the options available in the Dimension Style Manager dialog box.

Preview of: Standard

The image you see in the box below Preview of: Standard shows you the current dimension style and the way that dimension style is set up.

Styles

Below the word Styles: is a box displaying all the dimension styles available.  You can highlight any dimension style by selecting it with the left mouse button.

List

Below the word List: is a small rectangular box.  This box allows you to display either all the dimension styles available or only the ones in use in your current drawing.

Set Current

The Set Current button lets you set the dimension style that is highlighted in the Styles box to be the current dimension style.

New

The New… button allows you to create new dimension styles or modify existing dimension styles and save them as a different dimension style name.  The New… button opens the Create New Dimension Style dialog box.

[image: image57.png]_4 Create New Dimension Style

[Alldmensions

e






At the Create New Dimension Style dialog box, you can give your new dimension style a name.  You can also select what dimension style you would like to start with to create your new dimension style.

Modify

The Modify… button lets you modify the currently selected dimension style.  This button opens up the Modify Dimension Style dialog box as shown on the next page.
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"CENTER MARKS for CIRCLES"

Center marks for circles only apply to radius, diameter and center dimensions.  They are placed on those circles or arcs where dimensions are drawn outside the object lines.  When referencing size, it refers to the size of the center mark.  The following information will help you to understand how center marks for circles work.

1.  From the Dimensioning toolbar

2.  Select the Dimension Style icon [image: image59.png]


.
3.  At the Dimensions Style Manager dialog box, pick the Modify... button.  The Modify Dimension Style dialog box, as shown above, appears on your screen.  The upper right corner of this dialog box displays the current dimension style settings. The Center Marks for Circles image tile in the bottom right hand corner of this dialog box allows you to set the possible selections.  Pick in the white box where the word Mark appears.  You have the option of setting this variable to None, Mark, or Line.

4.  Variable settings:


A.  In the Center Marks for Circles image tile, activate the Line option by pointing to it and clicking your left mouse button.  Notice in the large white box that the circle now displays a center mark with lines.  

B.  Pick OK to accept this variable setting and pick Close to exit this dialog box.

5.  From the Dimensioning toolbar

6.  Select the Center Mark icon [image: image60.png]



7.  Command prompt sequence:


A.  Select arc or circle:  Pick any part of the top arc.  Now hit the Enter key and the Command prompt line again asks you to Select arc or circle.  Pick any part of the bottom arc.  A center mark with lines is now on both of your slot arcs.  If a center mark or none were only needed, they would be selected from the Modify Dimension Style dialog box.

Whenever you place center marks (lines) on your drawing, place all the center marks (lines) on each view using the above technique.  After all center marks (lines) are placed on your drawing, immediately go back to the Center Marks for Circles tile, pick in the white box where the word Line appears and pick the None option.  We do this because when we use the radius or diameter dimension command to dimension circles or arcs, there is not a second circle mark (line) placed on top of the ones we previously placed on our drawing.        

[image: image61.png]



"LINEAR DIMENSIONS"  


Linear dimensions can be horizontal, vertical or aligned.  Aligned dimensions have the dimension line parallel to the line where the extension line starts and ends.  Baseline Dimension and Continue Dimension are a series of consecutive dimensions that can be based from a linear dimension.  When linear dimensions are created, text, text placement, or the text alignment of the dimension can be modified.

1.  From the Dimensioning toolbar

2.  Select the Dimension Style icon [image: image62.png]



3.  In the Dimension Style Manager dialog box, pick the Modify... button


A.  In the Lines and Arrows tab, change the Color and Lineweight options (in both the Dimension Lines and Extension Lines tiles) from ByBlock to ByLayer by picking in the white rectangular boxes and selecting the ByLayer option.  

B.  In the Extension Lines tile, change the Extend beyond dim lines: value to 0.12.

C.  In the Arrowheads tile, change the Arrow size: value to 0.12.  

D.  Ensure you have changed the Center Marks for Circles tile option to None.
E.  Select the Text tab.  In the Text Appearance tab, change the Text color to

ByLayer and change the Text height to 0.12. 

F.  Select the Fit tab.  Under the Fit Options tile, ensure the black radio button is selected for Either the text or the arrows, whichever fits best. 


G.  Select the Primary Units tab.  In the Linear Dimensions tile, change the Precision from 0.0000 to 0.00.  In the Linear Dimensions tile Zero Suppression sub-tile (bottom left corner) pick in the white box to the left of Leading which will place a check mark ([image: image63.png]


) in the white box.  In the Angular Dimensions tile Zero Suppression sub-tile (bottom right corner) pick in the white box to the left of Leading which will also place a check mark ([image: image64.png]


) in the white box.


Pick the OK button to accept these settings and then pick the Close button.


The first object to dimension will be the front view of your Support Bracket (SBRACKET) drawing.

1.  From the Dimensioning toolbar

2.  Select the Linear Dimension icon [image: image65.png]


  

3.  Command prompt sequence:


A.  Specify first extension line origin or <select object>:  Select Snap to Endpoint or Snap to Intersection object snap and pick the lower left intersection of the SBRACKET.


B.  Specify second extension line origin:  Select Snap to Endpoint or Snap to Intersection object snap and pick the next point at the intersection directly above the first.  Now a ghosted image of the .38 dimension appears on your drawing along with arrows.


C.  Specify dimension Line Location or

      [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:

Move your ghosted image of the .38 dimension to the left of the object.  Make sure the ghosted image of the .38 is in between the extension lines, then type in .50 and hit the Enter key.  Your .38 dimension is now ½ " away from the object.  See Figure 2.2.
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Figure 2.2

We will now use another type of dimension called Baseline Dimension to do our second linear dimension.

1.  From the Dimensioning toolbar

2.  Select the Baseline Dimension icon [image: image67.png]



3.  Command prompt sequence:


A.  Specify a second extension line origin or [Undo/Select] <Select>:  Select Snap to Endpoint object snap and pick the endpoint of the lower left center mark line of the slot.  Press the Enter key twice to exit the command.  See Figure 2.3.
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Figure 2.3

One other dimension remains to be placed on the left side of the front view.  We will use Continue Dimension to place this dimension on the drawing.

1.  From the Dimensioning toolbar.

2.  Select the Continue Dimension icon [image: image69.png]



3.  Command prompt sequence:


A.  Specify a second extension line origin or [Undo/Select] <Select>:  Select Snap to Endpoint object snap and pick the endpoint of the upper left center mark line.  Press the Enter key twice to exit the command.  Your front view should look like Figure 2.4 below. 
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Figure 2.4

You can see that this .75 dimension is an incorrect way to dimension.  This type of dimension occurs using Continue Dimension when there is not enough space to fit the dimension lines and the text.  You can correct this leader dimension by using the Properties command.  Follow the steps listed below.

1.  Pick the .75 dimension.  You should see five blue boxes appear on your dimension when it has been selected.

2.  Select the Properties icon from the Standard toolbar.

3.  In the Properties dialog box, pick on the plus sign in the box to the left of the word Fit.

4.  Pick in the white rectangular box containing the words Text inside.  Now, to the right of the word Off, pick the black down arrow, and then pick the word On.  Exit the Properties dialog box by picking the black x in the upper right hand corner.  Hit the Ecs (Escape) key on your keyboard twice to exit the grip command.  Your front view should now look like Figure 2.5.
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Figure 2.5    

"RADIAL  DIMENSIONS"

Radial dimensions allow you to measure the radii and diameters of circles and arcs.  Optional center lines or center marks can be added as we did before (See pages 60-61).  Follow the steps listed below.  
1.  From the Dimensioning toolbar

2.  Select the Dimension Style icon [image: image72.png]



3.  In the Dimension Style Manager dialog box pick the Modify... button

4.  Make the Lines and Arrows tab current if it is not already.  Ensure the Center Marks for Circles tile has the word None as the selected option.  Pick the OK button, then pick the Close button.  We set this to None so there is not a second circle mark (line) placed on top of the ones we previously placed on our drawing.

5.  Select the Radius Dimension icon [image: image73.png]



6.  Command prompt sequence:


A.  Select arc or circle:  Pick any place on the top arc.  A ghosted image of the radial dimension appears on your drawing.  AutoCAD allows you to rotate radial dimensions to any point or position on the arc or circle you desire.


B.  Specify dimension line location or [Mtext/Text/Angle]:  Type in t for text and press the Enter key.  We will modify our text to read R.22, 2 PLACES.  Type in R.22, 2 PLACES and hit the Enter key.  Your ghosted image text should now read 

R.22, 2 PLACES.  Move your crosshair to the location where you want the radius dimension to be located and pick your left mouse button.  See Figure 2.6.
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Figure 2.6
PLACING TEXT ON YOUR DRAWING.

The following is a brief overview of how to use MultilineText and Dynamic Text. 
Text Composition.

Text composition deals with how the text is spaced, laid out and how it appears on your drawing.  Spacing is automatically done for you when using a computer.  AutoCAD automatically spaces lines of text equally apart to one-half the text height.  This maintains identity.  Lines of text are left-justified by default.  This means the text starts at a given location point and continues to the right side of the drawing.  

THE FOLLOWING TEXT SIZES WILL BE USED FOR MECHANICAL AutoCAD DRAWINGS: 


#5 Text:  Use .12 


#7 Text:  Use .24

How to Draw Multiline Text (Multiple Lines of Text).

The Multiline Text command allows you to draw more than one line of text and creates the additional lines of text as ONE OBJECT or ONE ENTITY.  The following is a brief description of each text option.  You can use any of these options to create the desired text box and text.


Height:  Sets text height.

Justify:  Sets justification of text.  The alignment of the entire box is set relative to the justification point.


Line spacing:  Allows you to adjust line spacing between the range of 0.5 and 4 times the height of the text.

Rotation:  This controls rotation angle of the paragraph.


Style:  Sets text style to be used.


Width:  Numerically sets paragraph width.

Inserting Multiline Text (Multiple Lines of Text).

1.  From the Draw toolbar

2.  Select the Multiline Text icon [image: image75.png]



3.  Command prompt sequence:

A.  Command:  _mtext Current text style:   "Standard"   Text height:   .20


      Specify first corner:  Pick a point to start the first corner of the text boundary. 

B.  Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/ Width]:  Type H for Height and press Enter.  Type in 0.12 and press Enter.

C.  Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/ Width]:  Now move the mouse around and notice that the screen cursor forms a box with an arrow in it and the prompt asks you to specify opposite corner.  Pick the other corner of the text boundary.  Text boundary width (left to right) is important because AutoCAD starts another line of text when your text gets to the right boundary edge.  Text boundary height (top to bottom) is not important because text that runs over the established height will resize the height of the box.  Once all options have been set you are ready to enter text for the paragraph.

4.  You now have the Multiline Text Editor dialog box displayed on your screen.  This basic Windows-Style editor allows simple text editing functions.  Here you can cut, copy and paste text if needed.  Type the following multiple lines of text:

FREEHAND LETTERING HAS BEEN A SLOW, TIME CONSUMING TASK. 

COMPUTER AIDED DRAFTING REDUCES THE TIME OF PREPARING LETTERING ON A DRAWING.  IN AutoCAD, LETTERING IS REFERRED TO AS TEXT.  USING THE COMPUTER ALLOWS YOU TO GENERATE TEXT QUICKLY, CONSISTENTLY, AND MAKES IT EASIER TO READ.

After the text is entered and correct pick OK to return to the drawing screen and exit the Text command.  The Text you just typed now appears on your drawing.
Note:  Multiple lines of text can be placed in a box of given format with the FIT option.  This justifies the text on both the left and right sides.  The letter height is the same for each line of text.  The letter width is adjusted to fit the boundary.  

Drawing Dynamic Text (DTEXT).

Start the DTEXT command now by typing dtext at the command prompt and hit the Enter key. 
Command prompt sequence:

1.  Command:  DTEXT

     Current text style:     "Standard"   Text height:    0.12

     Specify start point of text or [Justify/Style]:  Pick a point on your drawing where you want the text to begin.

2.  Specify height  <0.12>:  Press Enter to accept this text height.

3.  Specify rotation angle of text  <0>:  Press Enter to accept this rotation angle.  You should now see an " (" shaped cursor at the insertion point.

4.  Enter text:  Type in the desired text.  At the end of each line of text, press Enter and you can enter more lines of text as needed.  As you type, the text appears on the screen but is not displayed in its final position.

Note:  If you select another point on your drawing during this command, the " (" shaped cursor moves to that point, and you can continue typing more text in that area.

5.  Press Enter on a blank line to complete the DTEXT command.

STUDENT NOTES
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